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1 General

Congratulations! MotionBLITZ Cube is an excellent choice, because MotionBLITZ
Cube is a extremely versatile, advanced and self contained digital camera system. Mik-
rotron Deutschland GmbH has combined progressive camera technology with software
which is very easy to operate. Thus MotionBLITZ Cube is the ideal solution for high
speed recording. This manual provides information about the features and operating
modes of MotionBLITZ Cube.

1.1 Essentials of MotionBLITZ Cube

With the MotionBLITZ Cube - the Digital Motion Analyzer Recorder — rapidly moving
or explosive processes can be continuously recorded and stored at up to 190.000 im-
ages per second (Cube5) and can be displayed and analyzed in detail immediately af-
ter the end of a sequence. The images are always initially stored in the internal frame
memory of the camera. Because of the built-in rechargable battery, the camera can
operate up to 30 (60 Cube4/5) minutes in record mode and can store the recorded
data in the internal frame memory for up to 2 hours. Switch on the camera and after a
few seconds it is ready for high speed recording at full resolution without any additional
components. The MotionBLITZ Cube must be connected to a host PC via fast Ethernet
only when downloading recorded sequences or when camera parameters need to be
modified or changed.

1.2 Customer indications

1.2.1 For customers in the U.S.A.

This equipment has been tested and found to comply with the limits for a Class A digi-
tal device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio fre-
quency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will
be required to correct the interference at his own expense. You are cautioned that any
changes or modifications not expressly approved in this manual could void your author-
ity to operate this equipment. The shielded interface cable recommended in this man-
ual must be used with this equipment in order to comply with the limits for a computing
device pursuant to Subpart J of Part 15 of FCC Rules.

1.2.2 For customers in Canada

This apparatus complies with the Class A limits for radio noise emissions set out in
Radio Interference Regulations.
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1.2.3 Pour utilisateurs au Canada

Cet appareil est conforme aux normes Classe A pour bruits radioélectriques, spécifiées
dans le Réglement sur le brouillage radioélectrique.

1.2.4 Life Support Applications

These products are not designed for use in life support appliances, devices, or systems
where malfunction of these products can reasonably be expected to result in personal
injury. Mikrotron customers using or selling these products for use in such applications
do so at their own risk and agree to fully indemnify Mikrotron for any damages resulting
from such improper use or sale.

1.3 Declaration of conformity

Manufacturer: Mikrotron GmbH

Address: Landshuterstr. 20-22
85716 Unterschleissheim
Germany

Product: High Speed Camera MotionBLITZ Cube

The dedicated products conform to the requirements of the Council Directives
2004/108/EG for the approximation of the laws of the Member States relating to elec-
tromagnetic consistency. The following standards were consulted for conformity testing
with regard to electromagnetic consistency.

EC Regulation Description
EN 61000-6-3 Electromagnetic compatibility
EN 61000-6-1 Immunity

Unterschleissheim, August 31" 2006
Mikrotron GmbH

Bernhard Mindermann
Managing Director, Mikrotron GmbH
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1.4 Warranty Note
Do not open the body of the camera. The warranty becomes void if the camera body is

opened.

1.5 Remarks, Warnings
This document contains important remarks and warnings. See the corresponding sym-

bols:

@ Important remark

@ Attention, Warning
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1.6 Side and backside views of Cube cameras

1.6.1 The rear of the camera

The identification type plate is to be found at the rear of the camera. It contains the se-
rial number and the mac-address for identifying the device in a network.

A — = HAYHHOE —
y
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1.6.2 The right side of the camera
1.6.2.1 Connectors

There are 3 connectors, 2 switches and 2 LEDs mounted on the right side of the
Camera. The pin assignments of these connectors are described in chapter 8.2
Connector assignments

"Power " for connecting the power supply

"Signal input/Sync " for connecting digital and ettt : i
analog input, trigger- and sync-signals R FLERE SR IRER
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1.6.2.2 Switches

Power on/off

Start/Stop recording (trigger)

For cameras with standby facility, press the power switch longer than 1 second for
swichting off the camera! See chapter 2.1 “Standby (for Cube4 and Cube5 cameras
only)” for details.
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1.6.2.3 LEDs
With the color LEDs of MotionBLITZ Cube the actual operating condition is indicated.
Three colors are possible (and off-state):

RED
GREEN
ORANGE

1.6.2.3.1 Upper LED: battery charging and power indication

Color LED-state | Camera state

OFF - Switched off

RED constant | Switched off, battery charging in progress

GREEN constant | Switched on, no charging (battery full or no power
supply connected)

ORANGE constant | Switched on, battery charging in progress

In addition for Cube4 und Cube5 with according hardware version supporting the
standby facility:

RED/ORANGE flashing Standby mode with external power supply

GREEN/ORANGE |[flashing Swiched on, with internal power supply (battery)

With empty batteries it may take a few minutes of initial
@ charging until the camera can be switched on.
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1.6.2.3.2 Lower LED: internal camera state

Color LED-state Camera state
RED constant Boot procedure failure. Switch off the camera and try again.
ORANGE | 15 sec after |Power up boot procedure in progress
power on
GREEN | constant Ready for the first recording after power up
ORANGE | blinking Circular recording in progress, waiting for stop.
ORANGE | steady Circular recording stopped. Wait for next start signal

1.6.3 The front of the camera

The c-mount for the lens is located at the front of the camera.

ARy
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1.7 Scope of delivery

The following components are included as part of the delivery

1 MotionBLITZ Cube version as ordered, see selection below
1 Interface cable GigaBit Ethernet

1 110-220V power supply

1 CD with MotionBLITZ Cube operating software

1 Binder connector for signal Input
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1.8 MotionBLITZ Cube Versions:

Identifier Color Recording Max. Resolu- | Max. frame- |Lens
/b&w time [s] tion (4) rate[fps] mount

(1) (2) 3) (5) (6)
Cube1 M3 B&w 3 640x512 1000 CM
Cube1 M3, C | Color 3 640x512 1000 CM
Cube1 M6 B&w 6 640x512 1000 CM
Cube1 M6, C | Color 6 640x512 1000 CM
Cube2 M3 B&w 3 1280x1024 32000 CM
Cube2 M3, C | Color 3 1280x1024 | 32000 CM
Cube2 M6 B&w 6 1280x1024 32000 CM
Cube2 M6, C, | Color 6 1280x1024 | 32000 CM
Cube3 M3 B&w 3 512x512 128000 CM
Cube3 M3, C | Color 3 512x512 128000 CM
Cube3 M6 B&w 6 512x512 128000 CM
Cube3 M6, C | Color 6 512x512 128000 CM
Cube4 M B&w 1,5 1280x1024 93000 CM/FM
Cube4 M, C | Color 1,5 1280x1024 93000 CM/EM
Cube4 M3 B&w 3 1280x1024 93000 CM/FM
Cube4 M3, C | Color 3 1280x1024 | 93000 CM/EM
Cubeb B&w 1,5 512x512 1900000 CM/EM
Cube5 C color 1,5 512x512 1900000 CM/FM
Cube5 M3 B&w 3 512x512 1900000 CM/EM
Cube5 M3, C | color 3 512x512 1900000 CM/FM

(1) Additional configuration options:

HG indicates the Hi-G version (ruggedized for crash and vibration)
IB Camera has ImageBLITZ option
IG IRIG-B input processing option
MS Camera has Multi-Sequence option
M6 6 seconds recording time
PB Phoenix connector

(2) b&w black and white

(3) Cube1 seconds when using 1000 fps and 640x512
Cube2 seconds when using 500 fps and 1280x1024
Cube3 seconds when using 2500 fps and 512x512
Cube4 seconds when using 1000 fps and 1280x1024
Cubeb seconds when using 5000 fps and 512x512

(4) Width x height

—_ -
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(5) fps frames per second

Cube2 reduced resolution when using more than 500 fps
Cube3 reduced resolution when using more than 2500 fps
Cube4 reduced resolution when using more than 1000 fps
Cubeb reduced resolution when using more than 5000 fps

(6) Lens mount:
Cube1 / Cube2 / Cube3 CM = ,C-Mount*
Cube4d / Cube5 CM = ,C-Mount®, optional FM = ,F-Mount®

Cube3 / Cube5 have an increased photosensitivity (six times higher than the
Cube1 / Cube2).
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1.9 Power supply and charging

MotionBLITZ Cube cameras contain an integrated, rechargable battery, which provides
the necessary voltage for operation. Use an external power supply for charging the bat-
tery and for external power operation.

ted. Higher input voltages may seriously damage the camera. Damage of

Only voltages in the range from 10,5 to 24 Volts @ 15W max. are permit-
@ this type is not covered by our warranty.

1.9.1 Battery charging

MotionBLITZ Cube contains an integrated, rechargable battery. Thus the camera can
operate as stand alone without any power connection for up to 30 minutes of circular
recording with full resolution.

For Cube4/5 cameras this time will be increased to 60 minutes.

Stored images can be retained in the camera up to two hours with a fully charged bat-
tery .

The battery will be automatically charged when the power supply (10,5 -24 V DC) is
connected to the camera and the camera is switched off. Charging of a completely
empty battery will take 3 hours.

If the camera is switched on and a power supply connected, the battery is charged to a
fraction of its total capacity, it will operate a few minutes when disconnected from
power supply.

If the camera is switched on and a power supply is connected, the battery will be-
charged as well.

A fully charged battery will discharge within a few days when not used.

@ Always use an external power supply if the battery condition is unknown.
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2 Operating Modes

After switching on the camera it is ready for operation within a few seconds.
Cube4 and Cube5 cameras with according hardware version have a standby mode
available.

2.1 Standby (for Cube4 and Cube5 cameras only)

The intended purpose of the standby mode is to store the camera’s recorded images
for a longer time (up to ca. 20 hours) without any external power supply.

To manage this, in standby mode several components of the camera’s electronic will
be shutdown and mainly only the the image memory will be provided with power.

In standby mode, there is no access to the camera’s image memory.

To get the camera into the standby mode you have to

- press the camera’s power switch for a short moment (less than 1 second), when
the camera is ready-to-operate or

- configure it with the cube software as described in chapter 5.7.1 “Standby after
the end of a recording session” or in chapter 5.5 “The Camera menu”.

To get the camera out of the standby mode you have to press the camera’s power
switch for a short moment (less than 1 second).

than 1 second, you will shut down the camera com-

@ Please pay attention: If you press the switch longer
pletely and the camera’s recording will be lost!

The standby mode will be indicated by the LEDs in the follwing manner:
- the lower LED (TRIGGER) is switched off

- die upper LED (POWER) is flashing:

Power LED color Power supply advice
red / orange constant external
flashing
green flashing 1 .. 5 times |internal (battery) |If the battery is fully charged,
every 2 seconds there is a quintuple blinking.
If the battery gets emtpy, there is
a single blinking.
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2.2 Ready-to-operate

By means of the MotionBLITZ Cube software (control program) the camera can be set
up for recording in different operating modes.

If the camera is disconnected from the PC, reconnect it and press the reconnect
al | ‘ button in order to establish the GigaBit Ethernet link.

®

It is very important to press the reconnect button after the camera is reconnected
with your system. If this button is not pressed after reconnection the chronology
of a meanwhile recorded sequence may be lost!

The same applies to a completed recording session, that has been started with
the camera’s trigger switch.

MotionBLITZ Cube holds up to 8 Gbyte internal frame memory. From this memory, a
very small part (only as much as required by one frame) is used for storing the frames
for the live mode. The remaining memory is used for sequence recording.

2.2.1 Live mode

The camera images are continuously recorded and displayed. This mode is optimal for

defining image detail, adjusting the focus and setting up the various camera
live] parameters. Switch the camera to live mode by pressing the "Live" button.

2.2.2 Prepare for recording

When the camera parameters are adjusted according to the users needs while the
camera is connected to the PC, the camera can be disconnected now from the PC and
recording can be started via the trigger switch on the camera.
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2.2.3 Start recording

After power up, the camera starts with the last used settings. If you need another reso-
lution/frame speed, the new parameters must be entered via the MotionBLITZ Cube

control software.
There are 2 methods of starting the recording:
1. Press the Start/Stop recording switch on the right side of the camera.
In this case, a reconnect has to be accomplished after the completion of the re-

cording sequence in order to save the chronology of the pictures.

2. Press the red start recording i button in the MotionBLITZ Cube
control program —

2.2.3.1 recording modes

MotionBLITZ Cube has 2 recording modes. The difference is the usage of the camera’s
image memory.

2.2.3.1.1 Non circular mode

The camera stops recording when the internal frame buffer is full.

2.2.3.1.2 Circular recording mode

The camera records frames in a circular mode (i.e. the oldest frames are always over-
written by the newest) and waits for a signal to stop. There are 3 methods to stop re-
cording:

1. press the Start/Stop recording switch on the camera

2. apply a trigger signal (rising or falling edge, depends on setting “Trigger edge” in
form “Camera Setup”) to the appropriate camera input connector

3. press the Stop button in the MotionBLITZ Cube control program
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3 Installation of MotionBLITZ Cube

3.1 Minimal system requirements (PC)

For error-free operation of MotionBLITZ Cube the following minimum PC specifications
are required:

- Pentium Il 1GHz CPU with MMX-technology
- Windows 2000 or XP operating system

- 256 Mbyte PC Ram

- 10 Gbyte Harddisk

- 8 Mbyte graphic memory

- Display with 1280 x 1024 pixels

- GigaBit Ethernet Adapter

For optimal operation of MotionBLITZ Cube, a PC wth the following minimum
specifications is recommended:

- Pentium IV 1.8 GHz

- Windows XP

- 512 Mbyte PC Ram

- 40 Gbyte Harddisk

- 32 Mbyte graphic memory

- Display with 1400 x 1050 pixels / 24 Bit
- GigaBit Ethernet Adapter

3.2 Installation of the software

The GigaBit Ethernet adapter and driver should be installed before the MotionBLITZ
Cube software is installed. For details see the GigaBit Ethernet adapter manual.

Insert the MotionBLITZ Cube Setup-CD in the CD-Rom drive on the PC. Start the
setup.exe program and follow the instructions through the rest of the installation proc-
ess. After successful installation some network settings may be necessary, depending
on the actual network configuration. These settings are needed for assigning an IP-
address to the GigaBit Ethernet adapter and to the camera and described in the next
chapters.
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3.2.1 Assigning an IP-address to #h GigaBit Ethernet adapter

Assigning an IP-address to the adapter is only necessary, if no bootp-server is installed
in your network.

To assign an IP-address, perform the following steps:

1. Close all MotionBLITZ Cube applications.

2. Open the “Network and Dial-up Connections” window from the Windows Control-
Panel.

1 Network and Dial-up Connections e -0l x|
Eile Edit View Favorites TJools  Adwapeced  Help | i
dmBack ~ = - | @Search O Folders Qg | S 0 X w | i
Address Metwork and Dial-up Connections j a0
MName | Tvpe | Status | Device Mame | Ciner
IH Make New Connection

=t Local Area Connection LAM Enabled IntellR) PRO1000 MT Deskiop adapter System

H-Local Area Conmection 4 Lk Enabled 5i5 900-Based PCI Fast Ethernet Adapter System

1| | I
A

|3 object(s)

Right click on the desired connection in the panel and click the “Properties” item. The
properties dialog for the connection, shown in the next figure on the next page, will be
displayed.
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Local Area Connection Properties 3 2| x|

Gerneral | Sharing I

Connect Lzimg;

I B3 IntelR)PROM OO0 MT Desktop Adapter

LConfigure

Components checked are uzed by this connection;

. Client far Micrazoft Nebwark.s
File and Printer Sharing for Microsoft Metwark s
W Intermat Protacal [TCPAP]

Imztall... | Lninztall Froperties
Degzcniption
Allowwz pour computer to access resounces on a Microsoft
etk

[~ Show icon in taskbar when connected

OF | Cancel

- Highlight the Internet Protocol (TCP/IP) by clicking on the text-part, not on the
check-box.

- Click the “Properties” button. The next dialog will allow you to assign an IP-
Adress and the subnet-mask of the GigaBit network-adapter. See details on
next page in chapter
“3.2.2.2.1 Assign IP-Address 192.168.2.1 to the GigaBit Network adapter”

3.2.2 IP-Adress of the camera
Some settings are required depending on the Ethernet configuration:

3.2.2.1 bootp-server installed

The IP-address for the camera is assigned by the server. No other settings are neces-
sary.
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3.2.2.2 No bootp-server installed

3.2.2.2.1 Assign IP-Addresd92.168.2.10 the GigaBit Network adapter

After assigning the IP-Address 192.168.2.1 to the network adapter, set the subnet-
mask to 255.255.255.0.

Later on, in the MotionBLITZ Cube program, the IP-address 192.168.2.2 will be
automatically assigned to the first camera used. No other settings are necessary.
3.2.2.2.1.1 Assigning a different IP-Address to the MotionBLITZ Cube camera

The camera-network configuration file "mfggb.ini", which contains a section called
[CAMERA_REL] resides in the installation directory.
The entry

##CameralP00=192.168.2.2

can be found in this section. Delete the comment characters '##' and change the ad-
dress "192.168.2.2." to the desired address.

Example:

The Network adapter has the IP-address 193.122.3.9.

An IP-address for the camera should be assigned, where the network part of the net-
work adapter’s address and the part of the cameras’s address must be the same. How
many octets cover this part depends on the network address class:

Class A (beginning with 0...127) the first octet,
Class B (beginning with 128...191) the first and the second octet,
Class C (beginning with 192...223) the first,second and third octet.

In our example, 193.122.3.10, which is Class C, would be ok, because 192.122.3 are
the same in both addresses.

The entry in "mfggb.ini" could be:
CameralP00=193.122.3.10

Be aware of address conflicts with other devices in the network!
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3.2.3 The network configuration file "mfggb.ini".

As mentioned in the paragraph above, "mfggb.ini" resides in the installation-directory
and contains 2 sections.

3.2.3.1 Section [CAMERA_REL]

This Section contains the MAC Address of the used camera and network adapter. The
addresses will be registered by the Cube control program; no changes are to be done
by the user.

Example:

AdapterMAC=00-0E-0C-4C-E2-F0
CameraMAC00=00-50-C2-1D-7E-20

Beside this, the camera’s IP-Address may be defined here. See above for details.

3.2.3.2 Section [IPORT_PARAMS]

##InterPacketDelay=2000 // single camera on a Labtop computer
##InterPacketDelay=6000 I/l camera is connected to an existing LAN
##InterPacketDelay=100 // Default

InterPacketDelay=3000 /I Ethernet-switch

PacketSize=1440
RequestTimeOut=1000
PacketTimeOut=1000
AnswerTimeOut=1000
FirstPacketTimeOut=0

TabQuantity=2

COMDelay = 100 /l'in us

Depending on the system, use the appropriate parameter for the InterPacketDelay.

3.3 Connecting the MotionBLITZ Cube to the PC and starting program
To properly connect the camera to the PC please follow these steps:

1. connect the GigaBit Ethernet cable to the camera and then to the PC

2. connect the power supply to the camera

3. switch on the camera by pressing the power-switch

(see chapter Switches on page 10)

4. start the MotionBLITZ Cube Control programm. If it's the first start after installa-
tion of the MotionBLITZ Cube software, two forms will be displayed for selecting
the GigaBit Ethernet adapter and the MotionBLITZ Cube camera. Please select
the network adapter, click on “Apply” and select the camera and click on “Apply”.

Now the MotionBLITZ Cube is ready to operate.

3.3.1 Selecting the network adapter
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The form for selecting the network adapter willl be shown automatically after the first
start of the MotionBLITZ Cube program after its installation. You may load this form in
the Camera menu (“Select Network Adapter”) as well.

_;,‘ Select Network Adapter, Camera: MacroVis-4

Installed Metwaork Adapters:

P-4 ddress Subnet Maszk MALC Address Diezcription

192, 3 . 00-0E-OC-4C-E7-A8 IntellF] PROA1000 MT Desktop Adapter #3 - Paketplaner-kinipart
192.168.1.9 00-0E-46-37F6-1F Jealtek RTLE139-Familie-PCI-Fast Ethermet-NIC - Paketplaner-tinipor]

Select Adapter. | 00-0E-0C-4CE7-48
Used For Camera Access | 00-0F -0C-AC-E7-48 Apply | Close ‘

Basic software MotionBLITZ
Cube

8
Version: 1.7.3
Copyright [c] 1337-2007 Mikrotron GmbH. Al rights reserved.

Warning! This product is protected by copyright [asw!

1 Initialisation _..

Assign the network adapter for use with the program by clicking on the appropriate line
in the “installed network adapters” list and clicking on “Apply and proceed”. In the next
step, the form for selecting the camera will be shown automatically, if it's a programm
start without successfully selecting a camera before:
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3.3.2 Selecting the MotionBLITZ Cube camera

The form for selecting MotionBLITZ Cube camera willl be shown automatically after the
first start of the MotionBLITZ Cube program after its installation. You may load this
form in the Camera menu (“Camera Select”) as well, if you want to switch to another
camera.

Camera Select, Camera: MacroVis-4

Installed Cameras:
|P-Address
157 160 7 4

Camera Name
Macrdiz-4

Select Camera: | 00-50-C2-1D-7F-B4 | M acrotis-4

|Jzed Camera: | 00-50-C2-10-7F-BE4 Apply ‘ Scan Met ‘ Cloze ‘

Assign a camera for use with the program by clicking on the appropriate line in the in-
stalled cameras list and clicking on “Apply (and proceed)”. After the next automatical
steps with the initialisations for the hardware the system is ready for use.

3.3.3 Camera name

If you like to use a name for your camera, you may enter this name in the “camera
name” field of the ““Select Camera’-line of the “Camera select’-form. By clicking on
“Apply” this name will be used in the title of all other forms of the MotionBLITZ Cube
program.
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3.3.4 Multi camera operation

If you want to use two cameras simultaneously, you have to copy the contents of your
MotionBLITZ Cube installation directory into a new directory and start Motion-

BLITZ_ Cube.exe in this new directory as a second instance of the Cube control pro-
gram. By copying the Cube directory contents into other, separate directories and start-
ing MotionBLITZ_Cube.exe in this new directories you may use up to four cameras si-
multaneously.

For connecting the cameras with your PC you should use a Gigabit-Ethernet switch.
The following switches are recommended for use with the MotionBLITZ Cube cameras:

SMC TigerSwitch 86xxT family

3COM 3C1740x (3800 famliy)

Dlink DGS-10xxTx 10/100/1000 famliy

SMC 8505 or SMC 8508

NETGEAR ProSafe 16 Port Gigabit Smart Switch GS716T

3.3.4.1 Synchronizing cameras

For synchronizing MotionBLITZ Cube cameras you only have to connect the sync out-
put of a master camera to sync input of the slave cameras, as described in detail in
“4.2.4 Enable Sync in” and “ARM or “Sync out” signal”
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4 MotionBLITZ Cube in practice

The full range of functions available and all camera parameters may be set by means
of the MotionBLITZ Cube software.

4.1 The user interface

The camera is completely controlled through the user interface. All parameters of the
camera for recording, playback and saving the frames after recording may be adjusted
here. After recording, stored sequences of images maybe subsequently edited. Start
the software by double clicking on the appropriate MotionBLITZ Cube symbol on the
PC. desktop or choose the application in the windows start menu. The following screen
mask will appear:

¥ Mikrotron MotionBLITZ Cube, Camera:

File Cammera View Record Play 2

a4 [>[pal.s & ]

Select modes of operation or change parameters by pressing a command-button or by
selecting an item in a pulldown menu. If the mouse cursor is moved slowly over the
command buttons and symbols, information about each object will be displayed ("tool
tip text").

__
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4.2 Selecting resolution, speed, gain, trigger, sync, ARM and white balance

Click on the menu item "Camera" => "Camera Setup". This form will appear:

w. Camera Setup, Camera: MacroYis-4

Select resolution Resalution and recording rate ; Select resolution
by enterin lue [ Center Region Of Interest by click and drag
Horizontal 720
= ertical Gdd
| |
¢ Fived Frame Geometry
" Fixed Frame Ratz el
L .
Framesfssc 1530 Select shutter time
Select frame rate by ——————— | in microseconds
moving slider or 44 1590
entering L
M atirnum Recording Time [SEZ;/ use maximal shutter time
adjust black level ; e—/
e | Black Level Shuter Tine [usec] [0 |1 AF Max GSsiGw e e s
B | ] Low Light é__ﬂ—f——fi
adjust gain Gan s
_“————__________hh . w4 Active Edge [~ Enable Syncln L use external sync Slgﬂ8|
> 2 Syncln  GGEl  SyncdARM Dutput [
L & K C & CMOw @

hi

set default values for | Set Default C ¥ & ¥ & ospeon \gmgnms and

gain & b|8W \J RM output polarity
‘white Balamce ‘ Bppl Cloze ¥
/ﬁ) JEecic !

Clickon this button to o \q
Eo e Apply the entries for adj. signal polarity for Syacin, Close the form
resolution and framerate Trigger inputs

Once the changes to the parameters for resolution and framerate are set, click on
llAppIy ll.

Changes of resolution or framerate may alter the quality of recorded im-
ages. Be sure that you have saved your recorded images to file before ap-

plying these changes because afterwards the images may be destroyed or
lost!

Now the new parameters will be sent to the camera. All other parameters , e.g. shut-
tertime or analog gain, will be sent immediately to the camera  after entering.

If there is no connection to the camera, the following error message will appear:

Serial Camera Control, Camera: Cube 4

@ Setial communication error! Please check camera connectar
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Please make sure the camera is connected correctly. If a link is not established by
clicking on the reconnect button, read more in chapter “7, Troubleshooting”.

4.2.1 Gain

The gain may be adjusted with the 4 option buttons. You may increase the gain up to 8
(or 4 for Cube3/4/5). But please note: the quality of the image decreases the more you
increase the gain.

4.2.2 Black level

With the black level parameter (controlled with slider or text field) you may adjust the
camera’s image sensor base black level. The base black level must be set to a value
between 0 and 255. Setting to the correct value, the sensor will deliver the pixel value 0
(which means totally black) for a complete black image.

If the value is too small, the sensor will deliver a pixel value above 0 (which means
gray).

If the value is too big, the sensor will deliver a pixel value 0 (totally black) for images,
that are gray and not completely black.

The whitebalance form (for color cameras) or the histogram form (for monochrome
cameras) is a good tool for adjusting the black level:

In live mode, close the lens of the camera for getting a completely black image, adjust
the black level until the black line in the whitebalance or the histogram touches the
“min” border of the chart.

4.2.3 Low Light Mode

In low light mode the camera's exposure-time is extended up to 1023 milliseconds in
order to increase it's sensitivity. This mode is good for setting up the frame size and the
focus in live-mode. Select your exposure-time with the slider "shutter time" or input it
directly in the appropriate number-field. Low light mode will be automatically finished if
a recording is started.

4.2.4 Enable Sync in

With “Sync in” enabled it is possible to synchronize a MotionBLITZ Cube with other
MotionBLITZ Cube cameras.

- Connect the Sync out of your MotionBLITZ Cube master camera to the slave
cameras,

- connect the ground of the master camera with the ground of the slave cameras,
- select a frame rate for the slave cameras, that is slightly above the master cam-
eras framerate. Thus the slave cameras will be synchronized with the master

camera.
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4.2.4.1 Framerates of master and slave camera

If you synchronize a slave camera by a master camera, then the framerate of the slave
camera must be slightly above the master camera’s frame rate (as mentioned before),
otherwise the slave camera will not provide the same framerate as the master camera.

Example:

You want to record with 1000 frames per second. Adjust the master camera to the de-
sired 1000 fps, select 1004 fps for the slave camera. Then the slave camera will deliver
the master camera’s framerate (1000 fps)!

®

If “Syncin” is enabled and no “sync in” signal is provided, the camera will not
record and timeout will occur!

The framerate of the slave camera must be slightly above the master camera’s
frame rate:

Slave camera should be set up to framrate that is at least 2 fps higher than the
master’s framerate for Cube1 and Cube2 models and at least 20 fps higher for
Cube3 models.

Thus the maximal achievable real framerate will be about 2480 fps @ full
image resolution (512 * 512) for Cube3 slave cameras

4.2.5 Enable IRIG-B input

If the camera was deliverd with the option IRIG-B, the processing of the IRIG-B input
signal may be activated with the check box “Enable IRIG-B”. See chapter IRIG-B input
for details.

After activation, the signal will be processed in the following manner:

- decoding of the modulated 1KHz time code that is typically derived from a GPS
receiver.

- The time code will be displayed in the info line as day of the year and time of
day (GMT) in the following format:
ttt hh:mm:ss, whereas
ttt = day of the year
hh = hour
mm = minute

SS

= second.

- The internal frame rate timebase is then synchronized once per second to the
IRIG-B 1sec marker, and therefore phase aligned to the 1KHz IRIG-B signal.
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4.2.6 ARM or “Sync out” signal

You may choose between “ARM” or “Sync out” signal for pin 3 of the output connector
(see Table 8.2-2 )

4.2.6.1 Sync out activated

If you select “Sync out”, it is possible to synchronize other SpeedCam cameras.

The rising edge of the signal provided on pin 3 shows the beginning of the exposure of
the master camera’s image, the falling edge the end.

4.2.6.2 ARM activated

If you select “ARM”, you get a signal, if the camera is ready for triggering in the circular
recording mode.

For Cube4/5 cameras only: With the both check-boxes on the right side of the Sync
out/ARM you may define if ARM is active high or low. Please note: this does not apply
to the “Sync out” signal.
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4.3 Arrange a scene

Click on the "Live"-Button to get a live-image from the camera. The camera may now

be focused and aligned for the details of the scene. You may use low light mode to in-
crease the camera's sensitivity (available only in live-mode because on the other side
the framerate will be decreased!)

4.4 Recording in non circular mode

Non-circular mode is selected in menu "Record" => "record setting" => "non circular..".
To start, click on the red button. Now the camera starts recording and stops when the
internal buffer is full. During recording, the recorded frames are displayed simultane-
ously. After recording, the first (oldest) recorded frame will be displayed.

For Cube4 and Cubeb cameras there are firmware versions available for triggering in
this mode. See details in chapter “Record settings”

Recording in non circular mode may only be achieved with MotionBLITZ Cube
@ user interface program and not with the trigger switch or the trigger signal!

4.5 Recording in circular mode

Circular mode should be used if a trigger is applied.
The trigger may be
- the closing of the camera's trigger switch,
- atrigger signal,
- the ImageBLITZ
- the clicking on the stop button in the MotionBLITZ Cube control software.
A trigger is necessary if images are needed before and/or after an event. The trigger
defines the point of time of your event.

Circular mode is selected with menu "Record" => "record setting" => "circular..".
There are 2 methods to start and 3 various methods to stop the circular recording as
described in the next chapters of this manual. In circular recording mode the recorded
frames are displayed simultaneously. The number of frames that will be recorded be-
fore the trigger, called “pre-trigger frames ”, is determined in menu "Record" => "re-
cord setting" => "circular.."=> "Trigger Position ,Before [Frames]".

After recording, the frame immediately after the trigger will be displayed, the time-
stamps will be set in relation to the point of time of the trigger-moment, i.e. the first
frame after the trigger is set to 0 ms. Negative values indicate that the displayed frame
was recorded before the trigger, positive values indicate frames after the trigger, called
“post-trigger frames ”
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4.5.1 Start recording

There are 2 various methods of starting a recording:
1. Press the Start/Stop recording switch of the camera.

In this case, a reconnect has to be accomplished after the completion of the re-
cording sequence in order to save the chronology of the pictures.

2. Press the start recording button in the MotionBLITZ Cube control program.

The internal camera state LED (see 1.6.2.3.2 on page 12) will start flashing orange.
This indicates that recording is in progress and the camera is waiting for the trigger to
complete the sequence.

4.5.2 Stop recording

There are 3 various methods to stop recording
1. Press the Start/Stop recording switch of the camera.
2. Apply a triggersignal to the appropriate camera input connector.
3. Press the stop button in the MotionBLITZ Cube control program.

The internal camera state LED (see 1.6.2.3.2 on page 12) stops blinking orange. The
sequence is complete after the post-trigger frames have been recorded.
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4.6 Playback of a sequence

The frames in the camera may be accessed after recording. If the camera has been
disconnected from the PC's GigaBit-Ethernet it must now be reconnected and the
reconnect button in the Motion- ml BLITZ Cube control program must be
clicked on.

connected with your system. If this button is not pressed after reconnec-
tion, the chronology of a meanwhile recorded sequence may be lost!
The same applies to a completed recording session, that has been
started with the camera’s trigger switch.

@ It is very important to press the reconnect button after the camera is re-

Click on one of the forward or backward buttons. Now the frames will be displayed. Al-
ternatively the play settings menu may be used for selecting the frames.

P| 1 frame forward

4 | 1 frame reverse

Id| playback forward

b playback reverse

The frame counter shows the position within the recorded sequence.
The time stamp indicatesthe position relative to the trigger

A Mdirotron MeticnBLITT Culse | Camers
Fie Camern Wew Recod b 2

Al p[[E]ic o oo g SETE (e _
= Ml | D N o

= I

Use this "frame slider" to browse through your recorded sequence .

AR ey

MotionBLITZ Cube User Manual Ver. 1.8.0 35




4.7 Editing and saving a sequence

In high speed recordings usually only a portion of the frames contain relevant informa-
tion. Therefore, it is useful to save only that range of frames which contains this essen-
tial information.

There are 2 methods of selecting the essential range of frames for saving:
- Enter the range of the frame numbers in the "from" and "to" input field of the
"Save" or the "Make Avi" menu.
Alternatively you may enter the frame range by means of mouse-button and
control keys as described in the next chapter.
The selected range will be shown as a blue bar in the frame slider.
- Create a list of frames in the "Play settings" menu.
The sequence may now be saved as single bmp-files in the "Save" menu or as an avi-
file in the "Make Avi" menu . See chapter 5.4.2 and 5.4.3 on page 45 and page 47 for
detais.

4.7.1 Editing a sequence by using frame slider or keys

If the frame slider has the focus you may use the mouse buttons or the key “b”, “€” and
“I” for editing a sequence.

This method works only if the frame slider has the focus! Click on the frame
@ slider for getting the focus

4.7.1.1 Set the beginning of a sequence

_f Mikrotron MotionBLITZ Cube, Camera:

Fle Camera WView Record Play 2

4l nn}n Live| 2016 117 [ms] s —CH
] ;

O

filrn cuit - right se button: begihif‘t + right mouse buton: end

-

-

Press the right mouse button or the key “b”. The actual frame number, 2016 in the pic-
ture above, will be set as a start value for the range of frames. The selected range will
be shown as a blue bar in the frame slider.
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4.7.1.2 Set the end of a sequence

_,'_,f Mikrotron MotionBLITZ Cube, Camera: |3@E|

Fle Camera View Record Play 72

4 numu lve| 2637 s35imel () LR
) 1 f

0

” =

filrn cut - vight mouse button: begin, Shift + tight mouse button: end

L

Press the shift key and the right mouse button or the key “e”. The actual frame number,
2837 in the picture above, will be set as a end value for the range of frames. The se-
lected range will be shown as a blue bar in the frame slider.

4.7.1.3 Copy the selected range into the frame list

Press the key “I” for copying the selected range into the frame list.

4.8 Retrieving saved bmp-files

If the saved bmp-files are to be viewed, select the directory, the filename and the de-
sired frame numbers in the "File" => "Load" menu (chapter 5.4.1 on page 43). Now the
image source for displaying frames is the selected directory with the appropriate files.
This is indicated by the . symbol in the status area of the MotionBLITZ Cube
control-programm. @

The playback buttons or the "Play settings" menu allow navigation through the image
files as described in chapter 4.6 on page 35.

The MotionBLITZ Cube camera is set as image source by clicking on the "Live" button
or the red "Start Recording" button. This is indicated by the camera - symbol.
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4.9 Whitebalance (color cameras) / histogram (monochrome cameras)

Good illumination is extremley important for optimal true color display. Best results are
achieved by using daylight or halogen light. For recalibrating the color correction, click
first on "Live" and then in the menu Camera Setup on the button "white balance". The
following screen mask will be shown

. Mikrotron MotionBLITZ Cube , Camera: MacroYis-4
File Camera Wiew Record Play Tools 2 w White Balance, Camera: MacroVis-4

el .,_._u"ur__-f'-".Jl ILJ".JLJF"]I."'..-“."L,'J""—'L_

length of check line: |2D? |||:|i:-:el |

Auto Apply | Cloze |

Pisel Value &t Mouse Position
s A Act Mi_h G
360 5EE Gray Value 153 146 154
R 177 188 180

G 183 151 161
161 156 162

cameras a histogram will be provided instead. The histogramm con-

@ White balance is available for color cameras only. For black & white
tains only a chart without red, green and blue.
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4.9.1 Do the white balance manually

Adjust the size of the green check-line, which is automatically displayed in the camera
image, and move this line over a white area using the mouse. (Click and hold on the
line and move it).

Live

[” Histogam  length of check line:

Auto Appiy

~ Pivel Vahue At Mouse Position 4
e Y- Al
279 570 Gray Value 169

R 1E8
G 158
B 153

The values of the pixels along this line will be shown as three curves — red, green and
blue. Using the "R", "G" and "B"-sliders, move the three curves until they are nearly
congruent as shown in the figure above.

4.9.2 Automatic white balancing

Take a picture of a scene, that contains in its middle area mostly white. Click on the
“Auto” button.

4.9.3 Save the white balance values in the camera

Click on "Apply" to assume these values and to save them in the camera. Click on
"Close" to close the form.
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Multiple white balancing adjustments may be performed. If the images are
@ saved to a file, it is no longer possible to correct the color of these image-files.
Only frames downloaded from the camera are correctable before saving.

4.9.4 Provide the lenght of the check line

The green check line may be used for approximately determing the length of distances
between the starting point and the endpoint of the line. The value will be shown in the
field “length of the check line”. This value and its physical unit may be calibrated by en-
tering your values in both fields.

If you know e.g. in the upper example (,204 pixel), that this corresponds to 1.5 inch,
then input 1.5 inch. From now on the pixel will be converted into inch.
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5 Controls and menus in the MotionBLITZ Cube software

There are several menus and controls in the MotionBLITZ Cube program. Each will be
described in the following chapters

5.1 Moving the camera image
Click with the left mouse button on the camera image. Hold the button and move the
mouse. The image will move in the desired direction.

5.2 Zoom in and zoom out
For zooming, use the left vertical scrollbar. The range of the zoom factor is from 0.1
(smaller) to 10 (bigger) than the original.

% MotionBLITZ Cube, Kamera:

Datel Kamera Ansicht  aufhahrme Wiedergabe
I . S 034

Click on the zoom icon for the original size. The number next to the zoom icon
indicates the actual zoom factor. Doubleclick on the icon to fit the image into the form.
The icon gets green to indicate this.
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5.3 Brightness and contrast

The brightness of the image (right top vertical scrollbar) and the contrast (right middle
vertical scrollbar) are set. By clicking the scrollbar symbols with the left mouse button,
the initial state of the appropriate parameter is set. Adjust the base value for the con-
trast computation using ContrastBase. This is needed only in special light conditions.

&5 o [B
Al |al (4]

Brightness

Contrast >

ContrastBase Ll

LE E

@ Changes to contrast and brightness are relevant for the saved frames!

5.4 Menu File

g
.0 Mikrotron Ma
=8 Camera Wiew

Load...

Save..,
Make AT,

Exit
The File menu allows

- reloading bmp-files for display

- start saving images as bmp-files,
- create an avi-file and

- exit the program
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5.4.1 Reload bmp-files

w File - Load, Camera:

Frorm Ta Load
&+ Loop I | [1637 ]

" Frame List | | Cloze

[v Dizplay Framesz File Dialog...

|frames | | | |

framez000071 brp ~ | =" ﬂ
framez00002. brp
frarmes00003.brp et
frame=00004.brmp

] e | o —
frame=00006.brmp

frarme=00007 . brip
framez00003.brp
frame=00009.brmp
framez0001 0.brap
framez00011.brmp
frame=00012.brmp
frarme=00013.brnp

framesz0001 4.brp

MotionBLITZ Cube loads only bmp-files with 5 digit name endings. Files with the same
part before these 5 digits are assumed to be from the same saved sequence. To
reload a sequence (or a part of it) select the volume, the directory and the filename
without the digits.

There are 2 methods of selecting the single files to be loaded:

Load loop
Load frame list

5.4.1.1 Load loop

Click on the radio button "Load loop".

Entries can be made in the fields “From* and “To" by clicking on files on the file list with

the mouse:

- Click the contents of the “From* field with the left mouse button (number 1 in our
example). The background of the figure is blue.

- Click on the desired image file with the left mouse button, e.g. frames.bmp. “14“is
added to the “From“ field. The blue background disappears.

- Proceed in the same manner for the field “To“
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5.4.1.2 Load frame list

Click on the radio button "Load frame list"
The list may be edited in the menu "Play settings" (chapter 5.8 on page 64). Only the
files whose numbers are included in the frame list will be loaded and displayed.

w. File - Save, Camera:

Fram Tao
i Loop |5 | |1 4 |

i+ Frame List E-14 Cloze

Save

[v Dizplay Frames m

|Frames | | | |

Frames00007.brop S | =l j
Frames00002. brop
Framez00003.bmp S
Frames00004. brop

Frames00005 bmp D :
Frame=00006.brip =
Frames00007 . brop
Framez00008. bmp
Frames00009.brop
Frames00070.brop
Framez00011.bmp
Frames00071 2.brop
Framez0001 2. brrp

By clicking “OK* the first file is loaded into the main window.
Use the replay buttons as described in 4.6 on page 35 for displaying the whole
sequence.
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5.4.2 Save images to bmp-files

i, File - Save, Camera:

From To
{+ Laop [ | [3260 |

™ Frame List | | Cloze

Save

|x | omp | | |

cameratd enue. brmp | = ﬂ

- ol

(L3 ¥95teps
[E3 DocS
([ Dokumente und Einstellunger
[Z3 Images

[C3 IntelPRO I
[C3JPEG

(23] K.opie Work

(3 MEHepIDS

([ My InstallShield Express Proje s

[

Select a name from the file list below the bmp name field by clicking on it or by
entering a name on the keyboard. On the right side of the window it is possible to set
the hard disk drive and the path with the mouse.

It is essential to remember that if more than of 2 characters for the name are used, the
performance may decrease. Nevertheless, any name may be used which conforms to
Windows. MotionBLITZ Cube extends these characters by a 6-digit figure which
corresponds to the frame number. At present only “omp*“ data is supported, i.e. the
name suffix is permanently set to “.bmp*.

5.4.2.1 Save Loop

Click on "Save Loop*.

The numbers of the images in the range of “From” and “To" fields (including the values
themselves) are written to a file by clicking “OK".

The frame numbers may be also entered by using the frame slider and mouse-buttons
or keys as described in “4.7.1 Editing a sequence by using frame slider or keys”

AR ey

MotionBLITZ Cube User Manual Ver. 1.8.0 45




5.4.2.2 Save frame list

Click on “Save frame list".

The numbers of the images shown in the list are written to a file by clicking “OK®.

This list may be edited in the pull down menu “Play Settings”, described in chapter 5.8
on page 64.

In both cases (“from ... to“ and “Frame list“) each image and its file name are displayed
while being stored. If the "display frames" check box is NOT active, the frames will not
be displayed. In this case the saving procedure will be faster.

If a file with the same name already exists, a response to a message box is required.

Click on:

Yes The file and all the following files will be overwritten.

No The image will not be stored and, if possible, the procedure continues with
the next image.

Cancel The image is not stored and no further images will be processed.

The recording will be written to a file either with or without a image caption depending
on whether “infoline” has been switched on or off in the “View" menu (chapter 5.6.5 on
page 51).
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5.4.3 Make Avi File

Select the avi-filename, the numbers of the frames to be compressed and the
compressor-type by clicking on the "Compressor-setup" button.

A Make AVI, Camera:

A Setup
&4 Filename:

c:hSample.avi

Input Frames

f* From | 1| T|:u| E‘32|
O List | |

[+ Dizplay Frames
[ Clipping

AN Properties
A% Frame R ate:

Comprezsar Setup... | a0 | Frames / Sec
A4 Duration: .06 s
Make &4 |

Flay &b
| File Dialog...
Input Format
Wfidth: 1290
Height: 1064
Bits Per Pixel: o
Compressar

Cinepak Codec by B adiuz

| dentifier: cvid
[uiality: 100

Cloze

If only a special region of the sequence is to be processed, select this region by click-
ing on the "clipping" check box. An rectangle named "AVI clipping area" will be over-
layed in the camera image. Adjust the size as needed and move the rectangle over the
region of interest with the mouse. Once all parameters have been set, click on

"Make AVI.."

The Avi progress bar and the estimated time to completion will appear.

Creating A4
Progress:

(1]
Estimated Time: | 0.01:22

Finizh

If you click on “Cancel” while an Avi is created, the AVI will hold only the frames up to

the point of time of your cancellation.
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5.5 The Camera menu

File @ Yiew Record Play 7

4l

Camera Setup

o

F

Camera Select
Select Mebwork Adapter I
Standbey

Within this menu, you may

AR ey

with ,Camera Setup® check and change the camera’s parameter. See chapter 4.2
~oelecting resolution, speed, gain, trigger, sync, ARM and white balance” for de-
tails.

with ,Camera Select” connect with the camera via the ethernet. See chapter 3.3.2
~oelecting the MotionBLITZ Cube camera®“

with ,Select Network Adapter” select the adapter as described in chapter 3.3.1
“Selecting the network adapter”

with ,Standby“ set the connected camera into tzhe standby mode. More informaton
to this topic you will find in chapter 2.1”Standby”

MotionBLITZ Cube User Manual Ver. 1.8.0 48



5.6 The View menu

Fil= Camera Record Play ¥ Test

4|4 | Pl _FRaw
Input Ports
P 1 v Display While Recording
Marker
v Infoline
Infotext...

2

Language

5.6.1 Raw

The image is displayed as delivered from the camera without any modification and no
Bayer color-calculations. Thus in Raw mode always a black and white image will be
seen.

5.6.2 Input Ports

The values of the digital and analog input ports may be displayed, the value of the ana-
log port may be converted to a physical unit like “Volt” or “degree”.

Display Input ports

Convert Analog Values

5.6.2.1 Display Input ports

If “Display Input Ports” is enabled (checked), the 4 Bit digital input and the 8 Bit analog
input values of the camera is displayed in the toolbar. If "Infoline" is enabled (checked),
the values are inserted in the infoline, too.
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5.6.2.2 Convert Analog Values

The camera’s A/D converter delivers 0 for an input voltage of 0 Volts and 255 for 2,5
Volts. To convert the A/D value to physical units, use the form “Convert AD Value” and
edit the values “A” and “B” of the conversion formula:

Converted unit = A * X + B, where X is the A/D converters value.

If you want to display Volts, use for the factor A:
2,5/255 =0,0089039 and 0 for B.

With the display format string the number of integer and decimal places of the con-
verted value will be defined.

The number of zeros before the decimal point defines the minimal numer of integer
places, the number of zeros after the decinal point defines the number of decimal
places.

Example for the format string and the resulting output:

Format | comment Values to output:

string 0,3894 12,532
00.0 At least 2 integer place, 1 decimal places 00,4 12,5
00 At least 2 integer place, no decimal places 00 13
0.00 At least 1 integer place, 2 decimal places 0,39 12,53
0.000 |Atleast 1 integer place, 3 decimal places 0,389 12,532
.00 2 decimal places ,39 12,53
.000 3 decimal places ,389 12,532

w Convert AD Value E]@@

Formula For Converting Analog [nput Y alue =
A, =X+ B [Unit]
0,0098033] "~ +|0 Volt

Display Format 0.00

Apply Lloge
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5.6.3 Display while recording

Disable this point if the images are not to be displayed during recording.

5.6.4 Marker

Up to 4 markers may be enabled. Markers are magenta colored lines that overlay the
camera image. The size may be adjusted and moved with the mouse. Markers are
used for tagging the position of an interesting part in the replayed sequence.

®

Markers have no relevance for the saved frames!

5.6.5 Infoline

Attaching information to the recorded images is switched on or off. The information

portion is displayed as follows:

21.01.2008 18:08:00 021 17:08:01 b274

i1 1 i
-1774,0[ms] S01 D:1111 A:0,72 Volt

h12xb12, 1000 Hz, MotionBLITZ Cube #00105, ¥1.7.34
his is the info text. It may be edited in Yiew =2 Infotext

The upper part of this section taken from the SpeedCam main window shows the re-
maining part of a recording and the information portion. It contains the following fields
with information at the time of recording:

Field: Content in the example:
Date 21.01.2009

Time 18:08:01

IRIG-B time code (1), contains 021 17:08:01

3 characters day of the year

6 charcters for time of day, GMT

Frame number 6274

rel. time after trigger [ms] -1774,0 [ms]
Sequence number (2) S01

Digital input (binary representation) 1111

Analog input (decimal format) 0,72 Volt
Resolution, width x height 512x512

Frame rate 1000 Hz

camera type MotionBLITZ Cube
Serial number of camera #00105

Software version V1.7.34

Free text to be entered via “Infotext”

This is the info text. It may be edited in
View => Infotext
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This information portion is stored along with the frames while recording in the image
information block in the first image-line to save on frame memory. It is interpreted from
that structure for playback and then attached to the images.

(1) IRIG-B is an optional camera feature

(2) Sequence number is not available for Cube1 camera versions. Sequence number
indicates the number of the recorded sequence in multi sequence mode. See
“5.7.3.2 Multi sequence ” for details.
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5.6.6 “Infotext..."

Open the window “Edit Info Text":

m. Edit Info Text

The text entered here appears in the info line of all images:
Thiz iz the infotext. Edit thiz text in the Infotest field. ...

Lpply Ok Cloze

The text entered here and confirmed by clicking “OK*" is added to the information
portion in the recording sequence.

5.6.7 Language

German or English may be selected as language for all texts in the program.

5.7 Record settings

Recording Settings

Recording Mode

Mon Circular, Until End OF Buffer ﬂ
Recaording stops when buffer iz ful.
Standby

[ Activate Standby After End OF Becording

Cloze

The recording mode may be selected. There are 2 modes:
Non-circular mode
Circular mode

If Cube4 and Cube5 cameras have an according hardware version, they may switch to
standby mode automatically after the end of a recording session.
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5.7.1 Standby after the end of a recording session

If you have activated the check box “Activate Standby After End of Recording” in the
menu “Recording Settings”, the camera will switch to the standby mode automatically
after the end of the next recording session.

This activation is valid only for the next recoding session and will be deactivated auto-
matically afterwards.

By getting into the standby mode, the camera stops communication with the PC: Time-
out will be indicated therefore.

In order to get access to the camera’s image memory again, you must set the camera
into the ready-to-operate state: Please press the camera’s power switch for a short
moment (less than 1 second) and click at the “reconnect” button

5.7.2 Non-circular mode

Recording proceeds

- until the end of buffer is reached and stops afterwards or

- until the recording is aborted before by clicking on the “Stop” buttton or presseing
key F12.
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5.7.2.1 Without trigger

Recording Settings

Recording Mode
1 Circular, Until End OF Buffe |

Recarding stops when buffer iz ful.
Standby

[ Activate Standby After End Of Recarding

Cloze

For Cube1, Cube2 and Cubeg3 there is basically no triggering in the non circular mode,
for Cube4 and Cube5 it depends on the hardware version, if triggering is possible.

5.7.2.2 With trigger facility

Recording Settings

Recording Mode
Mon Circular, Until End OF Buffe ﬂ
Recording stops when buffer iz full.

Trigger Settings

* Mo Trigger
" Recording While Trigger |s Active
" Fised Murber OF Frames Per Trigger (Burst)

Cloze

Cube4 and Cube5 cameras with an adequate hardware version provide the triggering
facility in the non circular recording mode.

During a non circular recording session with triggering actual images
@ are shown as long as the camera provides them on account of the ac-

tive trigger. While waiting for the next trigger there are now images
shown.
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5.7.2.2.1 Recording while trigger is active

Recording Settings

Recording Mode
IHon Circular, Until End Of Buffer |

Recarding stops when buffer iz ful.
Trigger Settings

" Mo Trigger

" Fixed Murnber OF Frames Per Trigger [Burst)

v Trigger ‘ith External Signal
[ Trgger Witk ImageBLITZ

Cloze

As long as the trigger is active, recording will proceed. When the trigger gets inactive
before the image buffer is full, the camera is waiting for the next trigger. Not until the
end of the buffer is reached the recording ends (or if the recording was aborted before
by clicking on the “stop” button or pressing the key F12).

The trigger may be:

1. the camera’s trigger switch

2. an external trigger signal connected with the camera’s trigger input, provided
that , Trigger With External Signal“ in ,Record Settings” is activated. The active
edge or the active state of the signal may be selected in the menu “Camera
Setup” (Selecting resolution, speed, gain, trigger, sync, ARM and white balance)

3. changings of the contents in a specific part of the actual recorded image if Im-
ageBLITZ is used, i.e. “Trigger With ImageBLITZ” is activated (see chapter
5.7.3.1.2 “ImageBLITZ — optional” for details of ImageBLITZ).

With this trigger setting, the active state of the trigger is essential, not the edge.
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5.7.2.2.2 Fixed number of frames per trigger (burst trigger)

Recording Settings

Recording Mode
IHon Circular, Until End Of Buffer |

Recarding stops when buffer iz ful.
Trigger Settings

" Mo Trigger

" Recording While Trigger |5 Active

& Freed Murber OF Frames Per Tngger [Burstf

1 } 1022

v Trigger ‘with Extermal Signal
[ Trgger Witk ImageBLITZ

Cloze

For each trigger edge a preset number of frames will be recorded. The number may be
chosen between 1 and 1022.

Enter the number in the input field or move the slider into the desired position. In the
figure above 100 frames per trigger edge are selected.

After every recording, which was initiated by the trigger edge, the camera will wait for
the next edge as long as the end of the memory is not reached.

After reaching the end of the memory, the recording is completed. Alternatively the re-
cording may be aborted via the Stop button or F12.

As described in the chapter before, the trigger could be the camera’s trigger switch, an
external trigger signal or the ImageBLITZ.

With this trigger setting, the active edge of the trigger is essential, not the state.
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5.7.3 Circular mode

Recording Settings

Recording Mode
||:ir|:u|ar Buffer ﬂ

Recording stops by pressing F12 or tigger.
Trnager Position

* Before [Frames] (2025

" Befare [Percent]

1 ) 4049

[v Trigger ‘With External Signal Mumber Of Sequences

[ Trigger With ImageBLITS 1 -
. Lloss

The camera will record in a circular mode, i.e. the oldest frame is overwritten by the
newest. After triggering or the circular recording has beed stopped by clicking the stop
button or pressing the key F12 as many frames as defined in the input-field "Trigger
Position, Before [Frames] " (2025 in our example) will be kept and the rest of the frame
buffer will be filled up with frames. With the slider you may vary the triggerposition from
the first frame (“1”) to the last possible frame (“4049”) as well.

If you select “Before [Percent] ” the before frames to total frames ratio will be retained
if the total number of frames is changed (e.g. by changing the frame size)

Trigger with ImageBLITZ and number of sequences are not availabel for Cube1 cam-
era versions.

5.7.3.1 Triggermodes
MotionBLITZ Cube comes with two triggermodes, which may be selected independ-

ently. Select an external signal and / or ImageBLITZ by clicking on the appropriate
checkbox.

5.7.3.1.1 External trigger

If external trigger is selected, a rising or a falling edge, depending on the settings in the
menu “camera setup”, will bring the recording to completion.

AR ey

MotionBLITZ Cube User Manual Ver. 1.8.0 58




5.7.3.1.2 ImageBLITZ — optional

If ImageBLITZ is selected, changings of the contents in a specific part of the actual
recorded image will bring the recording to completion. This specific part is called the
“ImageBLITZ window”. The parameters of ImageBLITZ are adjusted in the “Recording
settings” menu in “Live” mode. The ImageBLITZ window is shown as a green, red or

yellow rectangle in the displayed frames.

@ ImageBLITZ is an optional camera version

Alternatively select ImageBLITZ
window gize and position by
enter-ing the values in this 4

fields

Select the number of sequences
with thiz ComboBox

Aecording mode

|Circular buiffer

_ Fecording ztop=z by prez=zing F12 or higger.

b\~ Triggen position -
L) % Before [frames]
i Befone [percent]

5]

404

1

I Trigoge with external zignal

bf saquancae

v Triggsr with ImageBLITE -

— ImageB LI TZ windows-

Left

250

“Width

Tap

E31

Haight

— Feleazs paamatars

Fisel swabie dff. 43
—_—

c[?s]:| 21

Ael object ziz
!

Click on "autg adjust” for setting

Select ImageBLITZ window size release parameters automatically
and position by click and drag

Don’t move or alter the ImageBLITZ window while recording. Movements while re-

cording have no effect.
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5.7.3.1.2.1 ImageBLITZ parameters

If ImageBLITZ is activated, the MotionBLITZ Cube camera compares the image detail
of the actual frame with the image detail of the reference frame. If the differences
within this image details exceed a limit, ImageBLITZ triggers (“releases”).

This two parameters for adjusting the ImageBLITZ may be set manually by entering
the values in the release parameters fields or automatically by clicking on “auto adjust”.

5.7.3.1.2.1.1 Pixel value difference

This parameter defines the absolute limit for the difference in the gray values within the
image details. The value range is 1 to 255.

With a small value small changings in the image detail let the ImageBLITZ trigger, with
a big value the ImageBLITZ trigger gets less sensitive. Under normal conditions, this
value should be between 10 and 70.

5.7.3.1.2.1.2 Relative object size

This parameter defines the relative size of the area within the ImageBLITZ window that
must be different from the reference frame before ImageBLITZ triggers. The value
range is 1 to 100 percent. If you use a small value, e.g. 5, then ImageBLITZ triggers
when 5% of the image details are different.

5.7.3.1.2.1.3 ImageBLITZ Reference frame

The ImageBLITZ reference frame is the first frame of a recording sequence, i.e. in Live
mode the first frame after starting Live, in record mode the first frame after starting the
recording. Using the auto adjust feature, the reference frame ist the next frame after
clicking on “auto adjust”

5.7.3.1.2.1.4 ImageBLITZ window colors

The color of the ImageBLITZ window borderlines is used for indicating the state of
ImageBLITZ:

color meaning

Green |ImageBLITZ is active and waiting for a trigger situation

Red ImageBLITZ is active and has triggered

Yellow |ImageBLITZ is not active (the system is not in Live- or recording mode)
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5.7.3.2 Multi sequence - optional

The frame memory may be divided into up to 16 same-sized memory ranges for se-
quences, called multi sequence mode. Each memory range is then filled by a trigger
event, i.e. by the occurrence of the external trigger signal or the ImageBLITZ trigger.
After a trigger event the post-trigger frames will be recorded and the camera switches
to the next sequence, beginning the recording of the pre-trigger frames. Thus the re-
cording proceeds till all sequences are complete.

If a trigger event occurs before the predefined number of pre-trigger frames are re-
corded, the number of pre-trigger frames will be less than predefined, whereas the
number of post-trigger frames will be as expected.

If a multi sequence recording will be stopped with the camera’s “Start/Stop recording”
switch or the Cube control program’s Stop button or key F12, MotionBLITZ Cube fills
the rest of the sequences, that are not yet recorded, with the number of post-trigger
frames and brings the recording to an end.

Multi sequence mode is provided only by means of the MotionBLITZ Cube control pro-
gram. There is no possibility to start a multisequence recording session if the camera is
not online.

@ Multi sequence is an optional camera version

There are 5 different numbers of sequences:

1
00 AN

6

For establishing the multi sequence mode, click on the ComboBox “number of se-
quences” in the form “record settings® with the left mouse button and select the number
of sequences you would like to record.

Please note: This ComboBox is only available in the “circular buffer” recording mode!
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Recording Settings

Recording Mode
|I:ir|:u|ar Buffer ﬂ
Recaording stops by prezzing F12 or trigger.

Trigger Position

¥ Before [Frames] |132
" Before [Percent]

1 J 406
[v Trigger ‘With External Signal MNumber Of Sequences
[+ Trigger 'ith ImageBLITZ |E ﬂ
1
ImageBLITZ Wwindow 2 i
Left | 190 | width [ 150 a
16

Top | 753 | Height| 18 H

After selecting the number of sequences, during the next recording session the number
of sequences will be represented by sequence command buttons, labled with the se-
quence-number:

¥ Mikrotron MotionBLITZ Cube, Camera:

Fle “amers Wiew Record Play 2

| I‘ll 'Il'l u ILiveI 37 Record rorf E
5 o
B 0 =

11:57:14 0037 5769,9[ms] S01 (462 Hz)

|

Resolution:(H): 1200 (V]: 1020 fps: 462 | Recording Time [sec] 3.8

T - T

The number of the sequence, that will be recorded actually, is represented by the
green color of the sequence command button. In the example above, ImageBLITZ had
triggered while recording the first sequence. The command buttons are disabled during
the recording session.
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After finishing the recording session, the sequence command buttons are enabled, by
clicking on a button you navigate to the frame immediate after the trigger event in the

appropriate sequence.

¥ Mikrotron MotionBLITZ Cube, Camera:

Fle Camera “iew Record Play 2

11:57:14 0219 0000,0[ms] S01 (462 Hz)

-/

Resolution:[H): 1200 ([¥): 1020 fps: 462 I Recording Time [sec] 3.8 \

Click here to use the frame slider for all sequences or one sequence only
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5.8 Play settings

In this form the number of the images that shall be displayed is defined. This is valid for
frame selection in the "file save" and "file Make Avi" form as well.

i Play Settings §|
Last Frame Mumber: 3275
Flay
" Single Frame -» Frarme List
i+ From |'IEIEI | Ta |12EI | i-» Frame List;

" Frame List [1-5
40
100-120

Delete

Delay

D [me] Cloze

L —

The behavior during playback in forward and reverse sequences is influenced by the
radio buttons; it is possible to set a time delay between the display of individual frames.

5.8.1 Display of individual frames

Click on the radio button “Single frame*“. The frame with the number shown in the entry
field "Single frame” is retrieved from the MotionBLITZ Cube frame memory and dis-
played. Any image desired may be loaded from the memory by entering the frame
number into the entry field or by operating the “frame slider” in the main form.

5.8.2 Display loop “from ... to*

Click on “from®. Enter the frame number of the beginnning and ending of the desired
range or select the range by using the “frame slider” and mouse buttons, as decribed in
4.7.1 "Editing a sequence by using frame slider or keys”.
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By clicking » “Forward playback® or 4 “‘Reverse playback” the frames within the
selected range will be loaded from the MotionBLITZ Cube frame memory and dis-
played in an infinite loop.

5.8.3 Frame List

The frame numbers selected via "Single frame" or “from ... to” can be added to the
frame list by pressing the “=> frame list“ button.

By pressing “Delete the numbers which were marked previously with the mouse can
be removed.

The contents of this list can be used for saving / loading images from files (in the “File”
window), for saving frames as an AVI (in the “File” -> “Make AVI...” menu) or for defin-
ing a playback sequence.

5.8.4 Display loop with frame numbers from frame list

Click on “frames list“. By clicking » “Forward playback® or 4 “‘Reverse playback®
all frame numbers are processed on the list in an infinite loop, i.e. the recorded images
are loaded from the MotionBLITZ Cube frame memory and displayed.

5.8.5 Last frame number

Depending on the size of the frame memory and the current frame size (line length and
number of lines) the last permissible frame number xxx is determined and displayed in
“Last frame number®. It is not possible to exceed this number in the display loop or
when displaying individual frames.

5.8.6 Slow motion (time delay in display)
To playback a sequence in slow motion, select the desired time delay in milliseconds in

the entry field “Delay [ms]:“. The time value may be entered in the field directly or
changed by using the appropriate horizontal scrollbar.
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5.9 Info form

. [nfo, Camera: MacroVis-4

e kel +:'.,_ kikratron kaotionBLITE Cube Wersion: 1.7.3
_11 Copyright [c] 1997-2007 Mikrotron GmbH. All rightz rezerved.

Camera Info

Senal-Mo.  [00108 Firmware-Yersion [B3.0141.13-F212
todel Type [Cubed MALC Address 00-50-C2-10-7F-Bd
Sensor Type [Calar IP-Address 192 168002004
Frame Memory 4 GEyte
Features: IC. M3, HG.IE. M5 e

YWharning! Thiz product iz protected by copuright [aw!

In the Info form details about the MotionBLITZ Cube control software and the firmware
of the actually connected camera are displayed.

The first part holds the MotionBLITZ Cube control software version number and the
copyright statement.

The second part holds information about the connected camera:
- Serial number of the camera

- Model type (Cube1, Cube2, Cube3, Cube4)

- Sensor type

- Firmware-Version

-  MAC Address

- |P Address

- The size of the frame memory

- Features

C Color sensor

M3 3 seconds recording time
M6 6 seconds recording time
HG Hi-G version (crash proofed)
B ImageBlitz

IG IRIG-B signal processing
MS Multi-sequence
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6 Maintenance

During normal use an occasional cleaning of the optical path is necessary. Information
about cleaning the lens is provided by the respective manufacturers.

6.1 Cleaning of the MotionBLITZ Cube infrared filter

MotionBLITZ Cube (color) contains a filter to suppress infrared light. Dust and dirt,
which may deposit on this filter is best removed by means of an oil free air pressure
spray or with a lens cleaning tissue. Sticky mud and fingerprints may be cleared away
with medical alcohol.

Improper cleaning agents may damage the filter. Such damage may alter
@ the quality of the images.

Infrared light is part of the visible light spectrum and warps the color in the
@ camera images. Therefore it is necessary to illuminate infrared light with the
filter.

6.2 Battery

The battery are four AA size NiMh accumulator cells.

B Batteries can be replaced by removing the cameras rear cover
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7 Troubleshooting

Any known software errors are listed in the release notes.
Main problems:

Q: The MotionBLITZ Cube establishes no camera link. An error message box
appears or “timeout” will be indicated. What to do?

A: Check, if the camera and the PC are connected via the ethernet. Check if the
Camera LEDs are in a state as described in chapter 1.6.2.3 on page 11. Click on the
"Reconnect" button in the Cube control program. If the color of this

button does not change to green (=connected), switch the camera off, switch the cam-
era on, wait until the lower LED turns green and try again.

A: Check if the camera LEDs indicate the ready-to-operate state (both LEDs must be
green or orange as described in chapter 1.6.2.3 on page 11)

A: Check if the windows firewall allows Mo  tionBLITZ Cube to work! If the firewall
is active, set it to inactive, close MotionB  LITZ Cube and start it again. If it works
now, you may configure MotionBLITZ Cube in the windows firewall as an excep-
tional program and activate the firewall again.

A: check if the MotionBLITZ Cube user has write-permission in the MotionBLITZ Cube
installation directory, e.g. c:\\Program Files\Mikrotron GmbH\MotionBLITZ Cube. Write
permission in this directory is necessary!

A: If you are using an ethernet switch to establish the data exchange with the camera,
it could take several seconds up to minutes, until the camera is detected after power
on or after connecting with the switch. In this case you should wait for 1 to 2 minutes
before you click at the reconnect or the “scan net” button

Q: In Live-mode and record-mode timeouts occur while “Sync In” is enabled
A: If “Syncin” is enabled and no “sync in” signal is provided, the camera will not record

and timeouts will occur! In this case you must supply the “sync in” signal to avoid time-
outs.
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8 Appendix
8.1 Technical data

8.1.1 Cubel / Cube2

Sensor type

Monochrome or color withBayer Filter

Number of pixel

Cube1 version:640 x 512 | other versions:1280 x 1024

Pixel size 12 x 12 ym
Active area 15,36 (H) x 12,29 (V) mm
Fill factor 40%

Sensitivity at 550 nm @ Vref

= 1V (a2 = 66h)

1600LSB/lux-sec

Spectral response

400 ... 800nm (color)
400 ... 1000 nm (monochrome)

Shutter

Electronic ,Freeze Frame® Shutter

Trigger

Asynchronous shutter, shutter time selectable with in-
ternal timer

Internal Dynamic 59 dB
Power supply 10,5..24V
Power consumption max.,

continuous recording @

1280x1024 resolution and 15W

500 frames/sec.

Thermal resistance typ. 6.25°/W

Serial data link

GigaBit Ethernet, Baud Rate 19200

Digital video GigaBit Ethernet

Operating temperature +5..45°C

Shock & vibration 100g, 10grms

Dimensions (WxHxD) 94 x 70 x 106 mm

Weight ca. 1050 g

Lens mount C-mount

Software "click, drag and drop" for Windows XP

Computer requirement

Min. Pentium 11l 650 MHz, 1024 * 768 pixel, 256 MB
RAM, 10 Gbyte Hard disk, GigaBit Ethernet

File format Avi or bmp

Recording frequency Cube1 version: other versions:
Up to 1000 Up to 45.000

Shutter time min. 4 us

Recording modes

Non circular or circular wih pre- and post trigger.

Frame buffer

2 Gbyte or 4 Gbyte

Replay frequency

10 - 30, fps @ 1280 x 1024, depending on the per-
formance of the PC
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8.1.2 Cube3

Sensor type Monochrome or color withBayer Filter
Number of pixel 512 x 512
Pixel size 16 X 16 ym
Active area 8,19 (H) x 8,19 (V) mm
Fill factor 62 %
Sensitivity at 550 nm @ Vref = |9 V/lux-sec
1V (a2 = 66h)
Spectral response 400 ... 800nm (color)
400 ... 1.000nm (monochrome)
Trigger External Signal,
ImageBLITZ Trigger (optional)
Internal Dynamic 57 dB
Power supply 10,5..24V

Power consumption max., con-
tinuous recording @ 512 x 512

resolution and 2500 15W

frames/sec.

Thermal resistance typ. 6.25°/W

Serial data link GigaBit Ethernet, Baud Rate 19200

Digital video GigaBit Ethernet

Operating temperature +5..45°C

Shock & vibration 100g, 10grms

Dimensions (WxHxD) 94 x 70 x 106 mm

Weight ca. 1050 g

Lens mount C-mount

Software "click, drag and drop" for Windows XP

Computer requirement Min. Pentium Il 650 MHz, 1024 * 768 Pixel,
256 MB RAM, 10 Gbyte Hard disk, GigaBit
Ethernet

File format Avi oder bmp

Recording frequency Up to 120.000

[frames per second = fps]

Shutter time min. 4 us

Recording modes Non circular or circular wih pre- an post trig-
ger

Frame buffer [Gbyte] 2 oder 4

Replay frequency 30— 100 fps @ 512 x 512, depending on the

performance of the PC
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8.1.3 Cube4

MC134x Monochrome-Bayer Filter

Number of pixel 1280 x 1024

Pixel size 12 x 12 ym

Active area 15,36 (H) x 12,29 (V) mm

Fill factor 40%

Sensitivity at 550 nm @ Vref = 1V (a2 = 6h) | 1600LSB/lux-sec

Spectral response 400..800nm (color)
400..1000nm (monochrome)

Shutter Electronic ,Freeze Frame" Shutter

Trigger Trigger and Sync input

Internal Dynamic 59 dB

Power supply 10,5...30V

Power consumption max., continuous

recording @ 1,3 GBytes/sec 15 W

Thermal resistance typ. 6.25°/W

Serial data link Thru GigaBit Ethernet,
baud rate 19.200 Bd

Digital video MC134x GigaBit Ethernet

Shock & vibration 100g, 10grms

Dimensions (WxHxD) 93 x 69 x 92 mm (c-mount)
93 x 69 x 128 mm (f-mount)

Case temperature +5 ... +45° C

Weight ca. 900 g

Lens mount C-mount or F-mount
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8.1.4 Cubeb5

Sensor type Monochrome or color withBayer Filter
Number of pixel 512 x 512
Pixel size 16 X 16 ym
Active area 8,19 (H) x 8,19 (V) mm
Fill factor 62 %
Sensitivity at 550 nm @ Vref = |9 V/lux-sec
1V (a2 = 66h)
Spectral response 400 ... 800nm (color)
400 ... 1.000nm (monochrome)
Trigger External Signal,
ImageBLITZ Trigger (optional)
Internal Dynamic 57 dB
Power supply 10,5..24V

Power consumption max., con-
tinuous recording @ 512 x 512

resolution and 2500 15W

frames/sec.

Thermal resistance typ. 6.25°/W

Serial data link GigaBit Ethernet, Baud Rate 19200

Digital video GigaBit Ethernet

Operating temperature +5..45°C

Shock & vibration 100g, 10grms

Dimensions (WxHxD) 93 x 69 x 92 mm (c-mount)
93 x 69 x 128 mm (f-mount)

Weight ca. 900 g

Lens mount C-mount or F-mount

Software "click, drag and drop" for Windows XP

Computer requirement Min. Pentium Il 650 MHz, 1024 * 768 Pixel,
256 MB RAM, 10 Gbyte Hard disk, GigaBit
Ethernet

File format Avi oder bmp

Recording frequency Up to 190.000

[frames per second = fps]

Shutter time min. 2 us

Recording modes Non circular or circular wih pre- an post trig-
ger

Frame buffer [Gbyte] 2 oder 4

Replay frequency 30— 100 fps @ 512 x 512, depending on the

performance of the PC

AR -

MotionBLITZ Cube User Manual Ver. 1.8.0



8.2 Connector assignments

8.2.1 ,Power” connector, male, type Binder (Cubel/2/3)

connector (male), view: Solder side

180°; Binder # 99-0413-10-05 (shielded, recommend.)
90°: Binder # 99-0413-75-05 (shielded, recommend.)

www.binder-connector.de

Pin Nr. Signal Level Description
1 Power +10,5..24V=
2 Power +10,5..24V=
3 n.c.
4 Power GND
5 Power GND

Table 8.2-1

8.2.2 “Signal input / Sync” connector, male, type Binder (Cubel/2/3)

connector (male), view: Solder side

180°; Binder # 99-0425-10-08 (shielded, recommend.)
90°: Binder # 99-0425-75-08 (shielded, recommend.)

www.binder-connector.de

Pin Nr. Signal Level Description
1 GND GND
2 0..2.5V@ Analog input voltage, 8-Bit resolution
1MQ
3 LVTTL Sync Output / ARM
4 LVTTL Digital Input 1
5 LVTTL Digital Input 2
6 LVTTL Digital Input 3
7 LVTTL Digital Input 4/ Trigger Input
8 LVTTL SYNC Input
Table 8.2-2
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8.2.3 ,Power" connector, male, type Lemosa (Cubel/2/3...-UPL, Cube4/5)

Pinning of matching power plug
(male, solder side)

select the plug according to your requirements
(right-angle plug / water-resistant etc.) under

http://www.lemosa.com/
0 o 5 e.g. straight plug: FGG.1B.305.CLAD42ZN
O ©
o O
3 4 (Mounted socket in camera: EEG.1B.305.CLL)
Pin Nr. Signal Level Description

1 Power +10,5..24V=
2 Power +10,5..24V=
3 n.c.
4 Power GND
5 Power GND

Table 8.2-3

8.2.4 ,Signal input / sync” connector, maletype Lemosa (Cubel/2/3...-UPL, Cube4/5)

Pinning of matching signal plug
(male, solder side)

select the plug according to your requirements
(right-angle plug / water-resistant etc.) under

PINB center http:
1 p://www.lemosa.com/
o) 7 e.g. straight plug FGG.1B.308.CLAD52ZJ
o ~0
3% 6
4 5 (Mounted socket in camera: EEG.1B.308.CLL)
Pin Nr. Signal Level Description
1 GND GND
2 0..2.5V@ 1MQ Analog input votage, 8-Bit resolution
3 LVTTL Sync Output / ARM
4 LVTTL Digital Input 1
5 LVTTL Digital Input 2
6 LVTTL Digital Input 3/ IRIG-B Input (optional Cube4/5)
7 LVTTL Digital Input 4/ Trigger Input
8 LVTTL SYNC Input
Table 8.2-4
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8.2.4.1 IRIG-B input

The level of the IRIG-B signal connected at pin nr. 6 should be typically 3V for ,mark’,
1V for ,space’. Important ist the ratio of the signal level of mark and space of 3 to 1.

8.2.4.2 Trigger/Sync input signal definition

The Digital Input 4/ Trigger and the Sync Input is isolated from the rest of the circuitry
by an optocoupler. The pull-up resistors R33/R32 are powered by a internal DC/DC
converter (X3.3V). The optocoupler will switch if the input is connected to the common
GND signal. (Pin 1 on Signal I/O connector).

A positive edge on the Sync input will output the next image.if the positive “Trigger-
edge” is selected in the camera menu.

A positive edge on the Trigger input will stop a circular recording if the positive “Trigger
edge” is selected in the camera menu.

X33V

RMI004 | RM100#

P i

DUIN4DOT7#
8 lvee 1
L N2 <
2 SYNC
3 ‘TR\GGER
6 oqﬁ/
5 A4
—= GND N
D3
IOKHCPLOB 3L 4 DUINAQQT7#

The minimum diode current for an active signal is SmA.
8.2.4.3 Trigger connection example

AR ey

MotionBLITZ Cube User Manual Ver. 1.8.0 75



Signal I/0 commector

Trigger
7 ag =/
1
Signal I/O conmector
Trigger 1000km
? =y
:_24"."

1 GMD

8.2.4.4 Analog input signal definition

Connection of an external trigger switch

Connection of an external trigger =signal
low =0-02Vv
high=3-24V

The analog input is protected by a 330kQ series resistor and adjusted to deliver the

digital value of 255 for 2.55V input voltage.
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8.2.5 Digital Inputs 1-3 signal definition

The signals DIG IN1-3 are TTL input signals and are used as process signals, which
are superimposed to the image.

+ 3.3V

U7-0
RO/ A1
DIG_INT [ — 9 ﬂ' A2
RD3 /A R0k § IF4HC14 4
RMATKH LU7-8
RO1/A1
DIG_INZ — > ﬂ oAb
RDI/B RM1OK4 ITAHCIA#
RM4, TH# U7-F
RO2/A2
;
DIG_INI i . 3 ﬂ 12
RD3/C RM 10K § [FAHC144
— - o), 0z D4
Rhd . TEA 5 /A ’l
L
DIZ2BACIVIY
GND

8.2.5.1 Sync/Arm Output

This pin can output a Sync signal or a arm signal, selected by a check box in the
camera menu. If Sync out is selected, this output will carry a Strobe that corresponds
to the selected exposure time of the camera. If Arm is selelcted, it will be active if the
camera runs in circular recording mode.

+3.3V X33V
A A
UT1 e R35
R34
pix 1 vee | 8 -
2 Tw e~ 2
= Z r
o 3
) zz\’\Dog S SYNC_OUT /ARM
GND D3 »
HCPL-0B3L /2 suppr. diode
5V/5A
XOND XGND

The optocouplers output will sink 13 mA with max. 0.6V output voltage. The output
polarity is positive when the selected signal is active. The suppressor diode protects
the output against reverse voltages. It starts conducting if the voltage on the output pin
is greater 6V.
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8.3 Spectral response

8.3.1 Cubel / Cube2

Quantum Effficiency for Color
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8.3.2 Cube3 / Cube5

Quantum Efficiency - Color
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8.3.3 Cube4d

25 7

Quantum Effficiency for Color
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8.4 Pixel sensitive area

8.4.1 Cubel / Cube?2

Pixel size: 12 x 12 uym
Fill factor: 40 %
Sensitive area: 10,5x 6,5 um

10.5
prm

12 pm

Sensitive Area /
6.4

urn

12 pm

8.4.2 Cube3 / Cube5

Pixel size: 16x 16um

Fill factor: 62%

Sensitive area: 8.19(V)x 8,19(H)um

8.4.3 Cube4

Pixel size: 12x 12um

Fill factor: 40%

Sensitive area: 10,5(V)x 6,5(H)um
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8.5 Dimensions
8.5.1 Top/bottom view Cubel/2/3

Maximum torque for M4 fastening screws: 2.5 Nm
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8.5.2 Side view Cubel/2/3

Maximum torque for M4 fastening screws: 2.5
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8.5.3 Top/bottom view Cube4/5

The camera body is with its dimensions of 93 x 69 x 92 mm (WxHxD, c-mount without
lens) very compact. To fasten the camera there are two mounting holes M4x7mm and
one tripod connection on each side available.

Maximum torque for M4 fastening screws: 2.5 Nm
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8.5.4 Side view Cube4/5
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